Instructions for setting up the
environment for java web PRJ301
(updated)

To develop and deploy a java web application on WINDOW, you need to follow 6 below

instructions:
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1. Installing JDK 17

https://www.oracle.com/java/technologies/downloads/

Products  Industries  Resources Customers Partners Developers  Company o] (B) Wiew Accounts [ contact Sales

Java downloads Tools and resources Java archive

Java 21 and Java 17 available now

K 21 s the | long- 5 lease of Java SE Plath
JDK 21 is the latest long-term support release of Java SE Platform. Learn about Java SE Subseription

JDK 21 JDKE17  GraalVM for JDK 21 GraalVM for JDK 17

JDK Development Kit 17.0.9 downloads

JDK 17 binaries ane fre 1o use in production and free 1o redistribute, at no cost, under the Oracle No-Fee Terms and Conditions (NFTC)

JDK 17 will receive updates under the MFTC, until September 2024, Subsequent JDK 17 updates will be licensed under the Java SE OTN License (OTH) and production use beyond the
limited free grants of the OTH license will reguine a fee,

Linux macOs Windows

Product/ffile description File size Download

w64 Compressed Archive 17242 MB hitps:/fdownload aracle.com,fjava 17 latest fjdk-1T_windows-x64_bin, zip [ sha25a)
w64 Installers 1533.51 MB hnps:ffdownload oracle.com,fjava/ 17 latest fjdk-1T7_windows-x64_bin.exe [ sha254)
xbd ME! Installar 152.30 MB https://download oracle com,fjava /17 latest /jdk-17_windows-x&4_bin.msi [ sha25e)

Documentation Download

After installing, let check the installation folder:
Normally it will be located at: C:\Program Files\Java. It contains 1 folder JDK-17.
If you see these folders, it is ok for now.

For more details, you can read

https://www.oracle.com/java/technologies/javase-jdk8-doc-downloads.html


https://www.oracle.com/java/technologies/downloads/
https://www.oracle.com/java/technologies/javase-jdk8-doc-downloads.html

2. Installing Apache Tomcat 10.1.x

Link: https://tomcat.apache.org/download-10.cgi

Open the installer file then click “Next” button, until you see the below screen:

Apache Tomcat Setup: Configuration Options —

X

Configuration % ™

Tomcat basic configuration.

Server Shutdown Port -1
HTTP/1.1 Connector Port 9999
Windows Service Name Tomcat10

Create shortcuts for all users [

| Tomcat Administrator Login ~ User Name |
(optional)
Password

Roles manager-gui

< Back | Next > J Cancel

By default, the HTTP port is set as 8080, but I prefer to change it to 9999. You can keep it as 8080

or change it as you desire. Same for Window Service Name.
You can also set username and password at this step, but it is an optional and you can do it later.

Click “Next”, then the installer will ask you for JDK-17 folder. Basically, the installer can

automatically detect JDK-17 folder, but in the case it cannot, you can add it manually.



@ Apache Tomcat Setup: Java Virtual Machine path selection =

Java Virtual Machine
Java Virtual Machine path selection.

Please select the path of a Java 11 or later JRE installed on your system.

C:\Program Files\Java\jdk-17

Mullsoft Install System v3.09

< Back Next >

Cancel

X

Click “Next” .... Again then “Finish”.

Normally, you are going to see the below window app displayed:




Apache Tomcat 10.1 Tomcat10 Properties (Local Computer) x
General |ogOn Recovery Dependencies

Service name: Tomecat10

Display name: Apache Tomeat 10.1 Tomeat10

Apache Tomcat 10.1.15 Server -

Description:
https:/ftomcat.apache.org/

Path to executable:
"C:\Program Files\Apache Software Foundation\Tomcat 10.1\bin\Tomcat10.¢

Startup type: Manual

Service status: Stopped
Start Stop Pause Resume

You can specify the start parameters that apply when you start the service
from here.

Start parameters:

OK Cancal Apply

It is ok, this application used to control your TOMCAT webserver, but if you do not see it, do not

worry. I recommend you follow below instructions:

1. TOMCAT now is installed as a Window Service (It is a software, but it does not have a
graphic user interface).

2. To work with Window Service, press window+R, fill service.msc

=] Run X

:] Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you.

Open: | ser\fices.msc| ~

Cancel Browse...




3. Find the TOMCAT service in the list:

& Services o : |
File Adion Weew Help
e @ Tc=Bm »@nn

7, Services (Local) _
Apache Tomeat 19,1 Tomcat 19 Mame Description Status Startup Type Log On As
«'.JJ'-MM Installer (AodnstSV) Pronvades Use_ Manual Local System I
arj tha sarscs et Actweation Runbirne_ 144711 Runtime for _ Marual Lol Systam
[ AN T Iy r3 & e Ak |rr,: 4 T3
Description: | C) Apache Tomeat 101 Tomeat 10 Apsche Tom. Manual Lol Service |
Apahi Tomeat 101,15 Sanver - i e — s
Weipe) Romoat spdcha.on Eb Application identty Determirs _ Manual Trigg-  Local Servics
E pplication Information Facltates th.  Running  Manual Tigg_  Local System
15 Application Layer Gatewary Servion Pronvicles. sup.. Manual Local Service
i App' Deployrment Service (AppXSWT) Provides infr. Runming  Manual (Trigg.  Local System
i Austo Tire Zone Updater Automaticsl Disabled Loscal Service
B meCTP service This is Audio.. Manual (Tigg-  Local Service
-C'J,Mynun-d Intefigent Transfer Service Transfers file-  Running  Automatic De.  Local System
-\'."J,Mynund Tasks Infrastructure Service  Windows inf.  Running  Automatic Lowcal System:
G Basa Fitering Engine The Base Fill.  Running  Aufomatic Local Service
16 BitLocker Drive Encryption Service BOESVChos.  Runming  Manual (Tigg.  Local System
s Block Level Backup Engine Service The WBENGI. Manual Local System
By Bluetcath Audio Gatewy Service Service supp. Manual (Tigg.  Local Service
& S Sanics, Tha Rt P R —
', Extended / Standard

Right click -> properties ->

Apache Tomcat 10.1 Tomcat10 Properties (Local Computer) X
General |ogOn Recovery Dependencies

Senvice name: Tomeat10

Display name: Apache Tomeat 10.1 Tomeat10

Description: Apache Tomeat 10.1.15 Server - a
https://tomcat.apache.org/

Path to executable:
"C:\Program Files\Apache Software Foundation\Tomcat 10.11bin\Tomcat10.¢

Startup type: Manual -

Senvice status: Stopped

Start Stop Pause Resume

You can specify the start parameters that apply when you start the service
from here.

Start parameters:

OK Cancel Apply

Now you can start/stop the TOMCAT service. Just make sure it is running before use.

You can grant permission for TOMCAT to run with Local System account on the same dialog.



Apache Tomcat 10.1 Tomcat10 Properties (Local Computer)

General LogOn R y Depend

Log on as:

0 Local System account
@ Allow service to interact with desktop

) This account: Browse...
Password:

Confirn password:

OK Cancel Apply




3. Installing Apache NetBeans IDE 17

Download: https://netbeans.apache.org/front/main/download/nb17/

= [ # netbeans.apache.org/front/main/download/mb17/

L Apache NetBeans

Downloading Apache NetBeans 17

Apache NetBeans 17 was released on February 21, 2023.
Apache NetBeans 17 is available for download from your closest Apache mirror,
Binaries (Platform Independent):

* netbeans-17-bin.zip (SHA-512, PGP ASC)

Installers and Packages:

* Apache-NetBeans-17-bin-windows-x64.exe (SHA-512, PGP ASC)

* Apache-NetBeans-17-bin-macosx.dmg (SHA-512, PGP ASC)
+ apache-netbeans_17-1_all.deb (SHA-512, PGP ASC)
* apache-netbeans-17-0.noarch.rpm (SHA-512, PGP ASC)

¢ Linux snap package

During your installation, remember to select JDK 17 (just in case, you have more than one version

of Java).

After installation, run Netbeans 17, File > New Project > Java with Ant > Select Web Application

(It is disabled by default, just select it, netbeans will automatically enable the project template).



4. Integrating Apache NetBeans IDE 17 with Apache

Tomcat.
+ First, open the Apache Tomcat folder:

By default, it is located at: C:\Program Files\Apache Software Foundation\Tomcat 10.1

The system may ask you to grant permission, just click “Yes” button. This step aims to allows your

account to access the Apache Tomcat folder for further tasks.

+ Open Netbeans, on the menu bar, Window > Service (Ctrl + 5) > select Service panel as

following:

l:,l File Edit View WNavigate Source Refactor Run Debug Profile Team Tc
- PMHEH A D Ve T E D-s

Projects Files | Services X _ StartPage X [&] indexhtml X

» [ Databases

> & Web Services

@ Maven Repositaries
& Cloud

¥ Hudson Builders
& Docker

@ Task Repositories
141 JS Test Driver

& Selenium Server

W W W W W W Y

Server > Right click > Add Server > Apache Tomcat and TomEE >



L) Add Server Instance X

Steps Installation and Login Details
1. Choose Server Specify the Server Location (Catalina Home) and login details
2. Installation and Server Location: - -
Login Details ! - | M Files\Apache Software Foundation\Tomcat 1[}.[){ Browse ...

Use Private Configuration Folder (Catalina Base)

(w]
[}
m

Enter the credentials of an existing user in the manager or manager-script role

Username:

Password:

? Create user if it does not exist

< Back Mext = Cancel Help

Here you can create your username and password, then finish. Now you can work with Java Web
project in netbeans 17.
If you get an error related to “CATALINA _base is Invalid”, check the first step.

Errors related to Tomcat will be logged to “C:\Program Files\Apache Software Foundation\Tomcat

10.1\logs”, check the catalina**** file for the detail logs.



5. Create Java Web project, Servlet and Debug.

To create a new java web project: File > New Project > Java with Ant> Java Web > Web

Application (See the below figure)

L) New Project

<

Steps Choose Project
1. Choose Project Q Filter:
2.

Categories:

Java with Maven
Java with Gradle
Java with Ant
JavaFX
Java Web
Java Enterprise
NetBeans Modules
HTML5/JavaScript

Description:

Projects:

@ \Web Application
& Web Application with Existing Source
38 webfreeformxml

Creates an empty Web application in a standard IDE project. A
standard project uses an IDE-generated build script to build, run, and

Aahiin uaur nraiact

/// LET DO IT, IN THE SESSION OF SERVLET

Cancel Help

Once you create new Servlet via Netbeans template file. By default, netbeans using javax, which is

not included in Jarkata EE platform equipped by Tomcat 10. Just need to replace all javax by

Jakarta package, then everything will be compiled.

U File Edit View Navigate Source Refactor Run Debug Profile Team Tools

o

Window  Help

PEES D TE D w0 @ sbeeeadC G

java.io.IOException;

java.io.PrintWriter;

start?path=/Demotieb
Start is in progress...

OK - Started application at context path [/DemoiWeb]

BUTLD &

CESSFUL (total time: 0 seconds)

Pro..x Files Services _ [@] indexhtml X |&] NewServietjava X jakarta.servlet.ServletException;
'xg DemoWeb Source  History | [1€ QRS e PLY Exl0 jakarta.servlet.annotation.WebServlet;
Q1_Ant .
@ webApplicationt 1B Jakarta.servlet.http.Httpservlet;
& Web Pages 2 nbfs . .
B Source Packages B oot jakarta.servlet.http.HttpServletRequest;
B <defautpackage> 5 L jakarta.servlet.http.HttpServlietResponse;
& Newservietjava
@ Test Packages
® Libraries €
B TestLibraries 7 [ import java.io.IOException;
& Configuration Files 8 t java.io.PrintWriter;
e avax.servlet. ServletException;
] avax.servlet.http. HttpServlet;
] avax.servlet.http. HttpServletRequest;
] import javax.servlet.http.HttpServletResponse;
13
14| &
15
NewServiet - Navigator X 16 tho.
Members v (=] .
& Newseniet:Hitpseniet! | ®  public class NewServlet ext
<& NewServiet) 19
% doGet(ttpsen al| 20/ B0
% doposttrity 21 Processes reaue for both HTTP ET ar POST:
O getServietinfo( : String
% processRequest(Htpse
Output X
[>  Apache Tomcat or TomEELog x  Apache Tomcat or TomEE X DemoWeb (run-deploy) X
w In-place deployment at D:\Teacher\PRJ301\Demo\DemoWeb\build\web
deploy?eonfig=fil 1 1578558418368 1.
@3 OK - Deployed application at context path [/Demoifeb]




Refer to https://tomcat.apache.org/ for more detail

you can also edit the template file for further tasks.

LJ File Edit View Navigate Source Refactor Run Debug Profile Team Tools Window Help Apache NetBeans IDE 17
PEE . o Y 3 ligszonuey G G
Pro.. X | Files Services @ indexhtml x @ NewServlet.java X @ Servlet X
@& DemoWweb Source  History [I&) [ = QaEasEN PR & @
& QiAnt . . 3 woogm
& Webapplicationt 1 <#assign licenseFirst = "/*">
5 Web Pages 2 <#assign licensePrefix = " * ">
@z Source Packages 3 <#assign licenselast = " */">
@ <default package> 4 <#include "S{project.licensePath}">
& NewServletjava =
@ Test Packages
& Libraries 6 <#if package?? && package != "">
g Test Libraries 7 package ${package};
@ Configuration Files g </HEif>
9
10 import java.io.IOException;
11 import java.io.PrintWriter;
12 import jakarta.servlet.ServletException;
13 <#if classAnnotation??>
14 import jakarta.servlet.annotation.WebServlet;
15 </#if>
NewServlet - Navigator x = _ 16 <#if includeInitParams??>
Members o il 17 import jakarta.servlet.annotation.WebInitParam;
ﬁ) NewServlet :: HttpServiet 1g </#if>
& NewServiet() 19 import jakarta.servlet.http.HttpServlet;
% doGet(HttpServ etRequ 20 import jakarta.servlet.http.HttpServletRequest;

ffu doPost(HttpServietReq 21

import jakarta.servlet.http.HttpServletResponse;
© getServletinfo() : String

// For one who cannot start debugging mode with apache tomcat 10. Open task manager window

then kill the process of Java SE.

Check the video: https://youtu.be/9Zcy7yWNAmM4

OR
Open window PowerShell, type command:

get-process


https://tomcat.apache.org/
https://youtu.be/9Zcy7yWNAm4
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Find java-se process id, then type command:

taskkill /pid 15760 /F

Now you can try debugging again with NetBeans and tomcat.



6. Working with JSTL.

Latest version of JSTL build on J2EE was 1.2x. Since the Tomcat 10 is using Jakartified version
(with jakarta.* package instead of javax.* package), use JSTL 2.0 to solve this dependency:

Download: Jakarta Standard Tag Library API

Link: https://search.maven.org/artifact/jakarta.servlet.jsp.jstl/jakarta.servlet.jsp.jstl-api/2.0.0/jar

@ M Inbox[132) sonnc.. o Mail - SenNgoTun.. ™ Tung Son Na Sy Personalize | QuilBor {3 SUBMISSIONFOR.. [T] DEI202 3 CrossoverinGeneti. ) google sieverifica.. 1 CCAI 2022 | Beiing 3 ICBDC 2022 | BigD.
(O sonatype | waven Central & Quick Stats © GitHub
jakarta.servletjsp.jstljakarta.servletjsp.jstl-api:2.0.0 X Q

jakarta.servlet.jsp.jstl:jakarta.servlet.jsp.jstl-api: 2.0.0 ¥ [ View on 0SS Index Browse [l Downloads ¥

Jakarta Standard Tag Library API ! Apache Maven [_D

Jakarta Standard Tag Library API maven.apache.org

Licenses EPL 2.0

GPL2 w/ CPE <depends

<grou
Home page https://projects.eclipse.org/projects/eed; jstl

Source code  https://github.com/ecli

-eedj/jstl-api

Developers Yamini K B, Oracle Corporation
Contributors Yamini K B, Oracle Corporation

Mailing lists  JSTL dev mailing list .
9 - i Cradls Cramnn NCH I—|_|

Download: Jakarta Standard Tag Library Implementation

org.glassfish.web:jakarta.servletspjstl:2.0.0 X Q
org.glassfish.web:jakarta.servlet.jsp.jstl: 2.0.0 T[4 View on 0SS Index Browse [l Downloads ¥
Jakarta Standard Tag Library Implementation [ Apache Maven |_|:|

Jakarta Standard Tag Library Implementation

maven.apache.org

Licenses EPL 2.0
GPL2 w/ CPE

Home page https://projects.eclipse.org/projects/eedjjstl

Source code https://github.com/eclipse-eedj/jstl-api

Developers  Yamini K B . Oracle Corporation

Check the document here:

https://jakart. ifications/tags/2.0/jakarta-tags-spec-2.0.html


https://search.maven.org/artifact/jakarta.servlet.jsp.jstl/jakarta.servlet.jsp.jstl-api/2.0.0/jar
https://search.maven.org/artifact/org.glassfish.web/jakarta.servlet.jsp.jstl/2.0.0/jar
https://jakarta.ee/specifications/tags/2.0/jakarta-tags-spec-2.0.html

7. Working with JDBC.

Add library sqljdbc42.jar and jaxb-api-2.1.jar to be able to perform jdbc related operations in java.
Download sqljdbc42.jar va jaxb-api-2.1.jar in internet.

Or: setups

Sau khi add thu vién thi trong project s€ nhu sau:

—

& Libraries
jakarta.servletjsp.jstl-2.0.0,jar
Jakarta.servletjsp.jstl-api-2.0.0)ar
jaxb-api-2.1jar

sgljdbc42 jar

&) JDK 17 (Default)

3 Apache Tomcat or TomEE

EDEDEDED

Ching ta c6 thé tham khao given project with jdbc theo link sau:
https://drive.google.com/drive/folders/1uaHyJLWOLfCFbn-5VQF7nPYyX{81H2Y ?usp=sharing


https://feedu-my.sharepoint.com/:f:/g/personal/tientd17_fe_edu_vn/EvHQQ7k9ORhHrEGq42kp70sB4cxlF3zSOUztNlYUJzMGSA?e=9dBLKQ
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